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Git & GitHub

» Git
o AAHE A T2
o B4 NEA
o A4 XEA(Web)
> Commit & Push
> Pull & Fetch

, ZAIAFO|E
o http://git-scm.com/

‘ \ local
workspace ;
repository

commit :>

push

pull or rebase

checkout

diff

<
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Git & GitHub

» GitHub
> Social Coding
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GitHub 7}l

(@) https://github.com/

Pick a username

' GitHub =S| O|X| & Your email
(http://github.com/)

Create a password

Tip: use at least one number and at least 7
characters.

By clickimg on "Sign up for free” below, you agree to
the Terms of Service and the Privacy Policy.

Sign up for free

See plans and pricing


http://github.com/

GitHub 7}l

Username

Login can't be blank

SEye o =
Create an account

HE 22

Email Address

We promise we won't share your email with anyone.

Password

Password can't be blank and ig too ghort (minimum i 7 characters)

Confirm Password

By clicking on "Create an account” below, you are agreeing to the

Terms of Service and the Privacy Policy.
|
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New repository

HE Sl

Your Repositories (1) Few repository

p—



GitHub X &2 d|el)

Owner Repository name

min6129 ~ /

N\

Great repository names are short and memorable. Need inspiration\WNgw about tripping-octo-hipster.

Description (optional)

(. Public
Anyone can see this repository. You choose who can commit.

N4 08 Y 3

Create repository

HE 22

O Private
Y ou choose who can see and commit to this repository.

[ ] Initialize this repository with a README
This will allow you to git clone the repository immediately.

Add gitignore: None ~

1

T




GitHub X{ X4 MM (1 E)

@ Search or type a command @ @ Explore Gist Blog Help

You don’t have any verified emails. We recommend verifying at least one email. Account seffings (You have no verified
Email verification will help our support tfiﬁfhg_u Ecase you have any email issues or lose your password. emails)
o/ —

Turn min6129 into an Organization

Create new organization ‘

ming&129
Profile o
Organizations
Account Settings
mobile-teamb Leave

Emails AN
Motification Center

Billing

e Account Settings >
Organizations > Create new
organization

SS5H Keys

Security History

Applications

- @—_——L 2|
Repositories = 1

Organizations

11




GitHub M%& 4 MHEd(QS)

Create an Organization

+" Sign up for a personal account Setup the organization

Setup the organization

Organization Name

The organization will live at hitps:/fgithub.com/

X 0| O &

'a
5
=)

o
21 S
= T

Billing Email

ate Organization

q
()

Receipts will be sent here

™
MO

rlm
[uu

Open Source  30/month 0 Choose




GitHub M%& 4 MHEd(QS)

Invite your team members

+" Sign up for a personal account +" Setup the organization

Add Owners to the fasdfs organization

min&129

“ I'm done here, continue to the organization dashboard

@=

Jm
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Eclipse A2 X]

» Eclipse Download

o http://www.eclipse.orqg/downloads/
> Eclipse Indigo HHA O|AF AX|

T Helios(3.6) | Indigo(3.7) | Juno(3.8)

SA|EE 2010 2011 2012

EGit plugin
x| of =

X O O



http://www.eclipse.org/downloads/

EGIT Plug-In Al X|

Help > Install New
Software... 2 &l

|Help|

3

@
,;%.-‘n

e

Welcome

Help Contents
Search

Dynamic Help

Key Assist. Ctrl+Shift+L
Tips and Tricks...

Report Bug or Enhancement...

Cheat Sheets..

Eclipse Marketplace...
Check for Updates
Install Mew Software...

About Eclipse

16



EGIT Plug-In AdX]

@ Instal I=lE] = |

Available Software
Select a site or anter the location of a site. é -

Work with: type or select a site s

Find more software by working with the “Avallable Software Sites” preferences.

http://www.jgit.org/
updates ¢ = “OK”

[type filter text

Mame
[7] (1) There iz

Details
[#] Show anly the latest versions of available software [T Hide items that are already installed
[#] Group iterns by category What s zlready installed?

[#f] Contact all update sites during install to find required software

@ < Back . Mext > Finich . Cancel |



http://www.jgit.org/updates
http://www.jgit.org/updates

EGIT Plug-In Al X|

Eclipse EGit {3 =
“Next”

&) Install

Available Software
Check the items that you wish to install.

T U W— =

Work with:  egit - hitp://www jgit.org/updates

type filter text

MName

(00 Eclipse Git Team Provider
i Eclipse EGit
| &= Eclipse EGit - Source

"

Find more software by working with the "Available Scftware Sites”

Version

2.3.1.201302201838-r
2.3.1.201302201838-r

Show cnly the latest versions of available software

[#] Group items by category

[7] Show only software applicable to target environment

[¥] Contact all update sites during install to find required software

[T] L EGit Mylyn 2.3.1.201302201838-r
[] 5+ EGit Plug-in Import Support 2.31.201302201838-r
i [ 000 JGit
| SelectAll || Deselect Al 1 item selected
Details

[ Hide items that are already installed
What is already installed?

®@

= Back Mext = Finish




EGIT Plug-In AdX]

Install Details
Review the items to be installed. s I

Marne Wersion Id
4 4§ Eclipse EGit (ncubation) _ 053 org.gcllpse.egit.feature.group
L Eclipse JGit (Incubation) 093 org.eclipse jgit feature group

4

Lize: Unknown
Details

An Eclipse Git Team provider in pure lava.

19



EGIT Plug-In AdX]

2 nstall

Review Licenses

Licenses must be reviewed and accepted before the software can be installed.

Licenses: License text

3
Q

Eclipse Foundation Software User Agreement

Accept = “Finish”

Eclipse Feundation Software User Agreement
April 14, 2010

Usage Of Content

THE ECLIPSE FOUMNDATION MAKES AVAILAELE
SOFTWARE, DOCUMENTATION, INFORMATION
ANDFOR

OTHER MATERIALS FOR QFEN SOURCE PROJECTS
(COLLECTIVELY "CONTEMNT).

USE OF THE CONTENT IS GOVERMED BY THE TERMS
AND COMDITIONS OF THIS

AGREEMENT AMDVOR THE TERMS AND CONDITIONS
OF LICEMNSE AGREEMENTS QR

MOTICES IMDICATED OR REFEREMCED BELOW. BY
USING THE CONTENT, YU

AGREE THAT YOUR USE OF THE CONTENT IS
GOVERMED BY THIS AGREEMENT

AMNDYOR THE TERMS AND CONDITIONS OF ANY
APPLICABLE LICENSE AGREEMENTS

Of NOTICES INDICATED OR REFEREMCED BELOW, [F
¥OU DO NOT AGREE TO THE

TERMS AND CONDITIONS OF THIS AGREEMEMNT AMD
THE TERMS AND CONDITIONS

@) | accept the terms of the license agreement |I

11 do not accept the terme of the license agreement

LM ¥

20



EGIT Plug-In AdX]

e =S | x5t =g
@ Installing Software “Restart NOW” H—l%

S Zalslg 0|22 A

=

= TYAIZE St

[ Always run in background

Installing Software
B — |
Installing Software:

Run in Back You will need to restart Eclipse for the installation changes to take effect. You may
try to apply the changes without restarting, but this may cause errors.

Iﬁ Restart Now I ’ Mot Mow ] [gpply Changes Now

21
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Project 2} 2&

E Java - Testl/src/testjava - Eclipse

Xk

S A

File Edit Source Refactor

Mavigate Search Project Run  Window Help

IERSE R AP Rl gl Ni=RTing

Go Into

b Open in New Window

Open Type Hierarchy
Show In

Copy

Copy Qualified Name
Paste

Delete

® B [

Remove from Context
Build Path

Source

Refactor

Import...
Export...

Refresh
Close Project

% LE

Close Unrelated Projects
Assign Working Sets...

Run As
Debug As
Profile As
Validate

Team
Compare With

i~ NHRG e E
[% Package Explorer i3 = B [3] testjava &2
BSle blic class test
J|W| public class test {
a New 3

F4
Alt+Shift+W »

Ctrl+C

Ctrl+V
Delete

Ctrl+Alt+Shift+Down
3
Alt+Shift+5 »
Alt+Shift+T »

F5

e

Quick Access

27

— o
v| x
Ei | 92 Java EE [:.i.Git Repository Exploring
= B8 [E] Task List 52 = 0
- g-I@BEl el % N
- ELAH 7|2 AL S
Find S| » All » Acti. D _I _IE O
o 24 X&rA
(@ Connect Mylyn 32

oSt &= -|
Ceonnect to your task E Al- o = = E
and ALM tools or create

a local task. D El AOHAO-I
v o B Project 2
N = 2|
=
e Team > Share

Project

Resource

Apply Patch...

Share Project...

Path

&

23



Project 2 EHX A A HAES6}7

e
(@] Share Project ESREER S

Share Project

j A EH

Select the repository plug-in that will be used to share the selected project. |i“r}:> C re ate |—-| L
o| =
2H HTUAR MY E

Select a repository type:
et

o 42 K|
Finish

Configure Git Repository ] B
i@ Configure Git Repository -
Configure Git Repository
Gl
Select an existing repository or create a new one l;Ln];‘
[7] Use or create repository in parent folder of project
Repository: test - C-lUsersitsseong2yaDesktopiiestttestnt git - Ili Create...
@ < Back Mext = | Finish Working directory: C#Userswsseong2yawDeskiopttestitest
Path within repository: Browse.
Project Current Location Target Location
(V] = Testl C:/Users/sseong2ya/Deskiop/testl/test1/T...  C./Users/sseong2ya/Deskiop,/test/test/Testl

—

[__finish__JJ | cancel




Project Commit o} 7]

T Java - testtt/src/testttjava - Eclipse - [E=RE=E ]
File Edit Source Refactor Navigate Search Project Run  Window Help
- Rt C' SRR R T < A I PR S Ne= R SRR A = -]
Quick Access T | 72 Java EE [ah) Git Repository Exploring
[ Package Explorer 5 = 0 [3] testttjava 52 = 8 [E] Task List 2 = 0
E= = - - = | = E
_J Ecbl’ Rlic -1 saceee { = ‘E]Gc"o »
3 L,_-?Js abe D R -
& Tz abe
» &% ddd Go Into Find G| » Al » Acti
.
4 TEg hell Open in New Window = -
; ] Fetch from Upstream
: ‘E_JU% Open Type Hierarchy F4 ; B tp&
iy ush to ream
. h Show In Atteshitw s | - (1) Connect Mylyn 2
a Remocte
= Copy Ctrl+C o lunen
n Switch To
B2 Copy Qualified Name = 2 local task.
b-l = % Paste Ctrl+V Advanced
Ty ww (= bt
i b 5 pul 55 Outline 3 = g
3 Delete Delete |s Pu
. i P EERR W e W
Remove from Context Ctrl+Alt=Shift+Down | #]  Synchronize Workspace - B
Build Path » Merge Tool ®, - tesit
Source Alt+Shift+5 » @ Merge...
Refactor Alt+Shift+T »
5 Reset
a3 Import.. U Rebase
5 Export.
Create Patch...
& —
| BEIE = Apply Patch... r
Close Project
Close Unrelated Projects il = v =g
=, L)
Assign Working Sets = Remove from Index
# | Ignore
Run As » 66 Untrack Path Location Type
Debug As 3 - — =
Profile As R ﬂ? Show in Repositories View
. =l Show in History
E
e Validate
Team » | I-f Disconnect
Compare With ig

24 HALAZ AR
S =0 02 M4

ol Project 2 &
Team > Commit

25



Project Commit o} 7]

Commit 1}
SHEHE

-
i@ Commit Changes

Commit Changes to Git Repository

‘%

Commit message

= = O
= ds &+

=s0A 5§48 ~

Y first comi‘t|

FEPET

Author: s880Ng2ya <ssecng2ya@ssecng2ya-PC=

Files (5/5)

Committer: sseong2ya <sseong2ya@ssecng2ya-PCs

)= O

|t}-‘pe filter text

Status Path

Test1/ classpath
Testl/ gitignore
Testl/ project

=
=

HEEEE
T D ) B

Testl/sre/test java

Test1/ settings/org.eclipse jdt core prefs

Commit and Eush] |

Commit

||

Cancel

26



Project Push o} 7]

@) Java - Testl/sre/testjava - Eclipse - ‘ E@g

File Edit Source Refactor Mavigate Search Project Run  Window Help

LEg . S G e B RS e O e i e s e e
Quick Access E | #9 Java EE [a Git Repository Exploring
[% Package Explorer 52 = O [4] testjava 22 = 8 [E] TaskList &2 =
J ICRA I - | a-l@l vl
Alg" Tést:m[tes_‘ New » v 'C')'H C} PI’OJ ect o =2
Y@@ ol Fnd @] » Al » adl. o =
Commit...
> [ Open in New Window ¥ I R t
1 = JRE Sy pe ) 1 Fetch from Upstream L eal I I > e I I I O e
Open Type Hierarchy F4 = -
Show In AltsShiftew » | ) Push to Upstream @ connect Mylyn o R t P h
Remote ¥ | %] Fetch From... e I I IO e > u S
5 Copy Ctrl+C :
- " @i Switch To »| =7 Push.
52 Copy Qualified Name -
| - Advanced b | &z Fetch from Gerrit...
[E Paste Ctrl+V P
% Delete Delete | &7 Pull =%z Push to Gerit..
| - ; £]  Confi Fetch f Upst
Remove from Context Ctrl+Alt+Shift=Down | ®]  Synchronize Workspace ) Configure Fetch from Upstream
. =] Configure Push to Upstream...
Build Path » Merge Tool
Source Alt+Shift+5S » % Merge..
Refactor Alt+Shift+T »
o Reset..
2y Import.. U Rebase...
£y Export...
Create Patch...
o Refresh FE Apply Patch... "
Close Project

Close Unrelated Projects Add to Index

Assign Working Sets... RETw R i T

4
=
¥ | Ignore
64

Run As 3 Untrack h Location Type
Debug As »
Profile As , [ Show in Repositories View
g Validate gl Show in History
Team » | I Disconnect

al

Compare With

27
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-

e @ htps://github.com/mosle-teambyiest O ~ @ GitHub, Inc. (US] © X || @) mobile-teamétest x o 3t _cl>__| 7_I:| I'I X} _+_ _7I<_ _+_ (I)=.| 7|

BRE FO LV FAYIW R0 S5 — o
x NAVER[- By BaE | k=02 Coe | Gog oeys Bzx pags Ezls | 230
9 2310|122/ 4R7| Edips.. ) GITI Github PHY LS. (@) twitter-typeahead s - Git... TEE D & Qe #REv E20v @
[ | A
® ® @ FExplore Gist Blog Help dus B ¥ B -

You don't have any verified emails. We recommend verifying at least one email.
Email verification will help our support team help you in case you have any email issues or lose your password.

mobile-team6 / test [ PullRequest @ Unwatch ~ & Star 0 [ Fork 0
E Code Network Pull Requests 0 lssues 0 Wiki Graphs Settings |
test ‘
I
4% Clone in Windows P 2P SSH  Git Read-Only flhttps://github. com/mobile-teamé/test.git [ | Read+Write access =
7 branch: master - Files  Commits  Branches 1 Tags
I
test/ [ D 4 commits
third commit (deok)
I

sseong2ya authored 2 hours ago commit eddBeafifc b

o

B testtt 2 hours ago third commit (deok) [sseong2ya]

We recommend adding a README to this repository. Visit github/markup for details on what formats we support.

GitHub Applications Services Documentation More

®100% v

28
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M B
i@ Push to Another Repository & . E‘Elg
Destination Git Reposito
pository G |_|_|
Enter the location of the destination repository.

i

() Configured remote repositary:
origin: https://github.com/mobile-team&/test git

@ Custom URL

i https://github.com/mobile-teamé/test.git]
Hest: github.com

Repository path: /mobile-teame/test.git

= Protocol ZEL
https

Authentication
User:

Password:

Store in Secure Store [

@ = Back Mext = | Finish Cancel




Project Push o} 7]

ﬂ Push to: https//github.com/mobile-teamé,test.git

Push Ref Specifications
Select refs to push.

Add create/update specification

Source ref:

* #

HEAD

predefined specification

Add Configured Push Specs

Add All B

Specifications for push

Mode Source Ref Destinatio

Destination rf”

@) Push to: hitps://github.com/mabile-teamé/test.git

Push Ref Specifications
Select refs to push

Add create/update specification
Source ref:
¥ refs/heads/master -

Destination ref:
refs/heads/master

Force Update
=3 Al 7|=
M EHE|0] Q) T

T 2NE T} A

Al E[7] =

Add delete ref specification
Remote ref to delete: A

Add predefined specification

I

Add Configured Push Specs Add All Branches Spec

Specifications for push

Mode Source Ref Destination Ref Forcy

Force Update All Specs

-
E Push to: https:/github.com/mobile-teamé/test git

NERSN

Push Ref Specifications
Select refs to push

Add create/update specification

Source ref Destination ref

| -
* *

Add delete ref specification
Remote ref to delete: "

Add predefined specification

Add Cenfigured Push Specs Add All Branches Spec

Specifications for push

Destination Ref
refs/heads/master

Source Ref
refs/heads/master

Mode
4F  Update

1]

[ Force Update Al Specs| [ [ Remove All Specs

(

Finish

J |

Cancel

30




Project Push o} 7]

M - . — " . e N . : , — .
i Push 10 Ll e 18] Push Results: hitps.//github.com/mobile-teamé/testgit l -— e
Push Confirmation G 1'_'
Confirm following expected push result. [_-(_): 4 Pushed to hﬂpﬁ:f !github.com! mobile-teamﬁf tﬁtglt
&5, master: master [up to date] =
&, master. master [up to date] =

Message Details
Repository https://github.com/mobile-team6/test.git -

Message Detalls
Repository https://github.com/mobile-teamé/test.git -

[1Push only if remote refs don't change in the mean time
[]Show final report dialog only when it differs from this confirmation report

l Configure... ]

wot- [C_gnsh J)[ cance

31




Eclipse@} GitHub =

.

'@ Import

-:-Ehg

Select

Impeort one or mere projects from a Git Repository.

“,

=]

Select an import source:

ftype filter text

= CVS
[ = BB
4 = Git
% Projects from Git ||
= Install
[» [= lava EE
i = Plug-in Develcpment
[» [= Remote Systems
i = Run/Debug
[ = Tasks
[ = Team
B = Web
= Web services
[ = XML

m

1

=]

1. File > Import...

2. Git > Projects from Git

3. Next

—

32



Eclipse?} GitHub ¢S 5}7|

-
%) Import Prajects from Git EEERs
Select Repository 5o
pository Source G J_'_l
Select a location of Git Repositories — = 4
type filter text
1 Local
%] URI|
1. URI /dEH
[ ] I_ _I
2. Next
Cancel

33



Eclipse}l GitHub 4= 5}

.
f@] Import Projects from Git % - E@g

Source Git Repository

~

ML
Enter the location of the source repository. "=
-
Location
| URL v https://github.com/mobile-teamé/test.gif || Local File...
Host: github.com

Repository path: /mobile-team&/test.git

Connection

Protocol:

Port:

Authentication

User:

Password:

Store in Secure Store [

Cancel

34




Eclipse®} GitHub &

e w

'@ Import Projects from Git

| ) |
Branch Selection

Gl
Select branches to clone from remote repository. Remote tracking branches : 1_]'=|
will be created to track updates for these branches in the remote repository. -

Branches of https.//github.com/mobile-teamé,/test. git:
type filter text

&3, master

Select All | | Deselect All

ext = ] ‘l Einish

@ " Back [

=

SOt

~

35



Eclipse}l GitHub 4= 5}

~
'@ Import Projects from Git ¥ . - Elﬂlg
Local Destination
Configure the local storage location for test
Drestination
Directory: ContUsersemindDesktoptestatest?

Initial branch: | master

[ Clone submodules

Configuration

Remote name: origin

] ‘l Einish

Cancel

¥ —

~

1. 28 HAAS AR

Cl=E 2] XS

2. Next

St

36



Eclipse2} GitHub ¥4 =35}

~

'@ Cloning from https://github.com/mobile-teamé/test.git @31
2174 HRFA O A
=
Select a wizard to use for importing projects GIT ': 1 I'“-I o _I_O.II -I
Depending on the wizard, you may select a directory to determine the | [_]"'A iE = E 7I-x:l 27'
wizard's scope -
Wizard for project import
[® 1mport existing projects 1. Import existing
() Use the Mew Project wizard .
projects

(7 Import as general project

(7= Working Directory - C:WUsersimin#Desktopnewivtest

2. Next

\ 3. Finish )

Cancel

| ‘l Finish

37




Eclipse®} GitHub &

i8] Java - Testljsro/tastjava - Eclipse

. T i

File Edit Source Refactor MNavigate Search Project Run  Window Help
i G e E NS e O i g G s e |
Quick Access E | @ Java EE [a Git Repository Exploring
[ Package Explorer &2 = 0 [J] testjava &2 = g [E] TaskList &2 = g O
TICNA S - c-@sree [ O[O] Import Z| O R
a [I=5 Testl New 5 - .
e . . = Project7t =7
« H o Into e - Find Q| » All » Acti. [ o
ommit...
b Open in New Window o | ot o s El AHEe 7:' @) PUIIE
b B R Open Type Hierarchy F4 ::] o ch tmL:n tp& ream A = O
Show In Altsshiftaw | = Push fo Upstream @ Connect Mylyn 7 |_ L—_l_-L * Al E[fe)
B Copy ClrlsC Remote —_ L o L | -
= +
- &5 Switch T
E2  Copy Qualified Name & A": ¢ 3 E—I E 7” Al 7 |-h
[ Paste Ctrl+V vance O o
¥ Delete Delete
= . PEER W e x
Remove from Context Ctrl+Alt+Shift+Down | ¥ Synchronize Workspace - “
Build Path » Merge Tool ©® tost
Source Alt+Shift+5 » % Merge..
Refactor Alt+Shift+T »
&% Reset..
g2y Import.. U Rebase...
£y Export...
Create Patch...
o7 Refresh = Apply Patch... x
Close Project
Close Unrelated Projects Rl [ aliex I
=, ¥
Assign Working Sets... = Remove from Index
¥ | Ignore -
Run As » 6§ Untrack Path Location Type
Debug As » - : P
Profile As 5 [?7 Show in Repositories View
) s Show in History
Ef
g Validate
Team » | &~} Disconnect
Testl Compare With 3 i@

38
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